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1. Overview

1.1 What is Unity IAP for Xiaomi IAP
Unity IAP provides an easy way to integrate Xiaomi IAP with Unity.

1.2 Process of using Unity IAP

Please append “.mi” to your package name, e.g. “com.unity.mygame.mi”

a. Technical Integration



I. Onboarding to Unity

Il. Server side integration

llI. Client side integration
b. Build and Submit APKs

2. Login & Purchase Flow

Unity IAP both supports the stand-alone game (without a game server) and online game

(with a game server).

2.1 Stand-alone login & purchase

In the ‘init SDK binding’ step, the Xiaomi appld, Xiaomi appKey (both of these
given by Xiaomi) and the Unity Client Id, Unity Client Key (both of these given by Unity,
see 2.1 Onboarding to Unity for details) will be used to initialize the Unity IAP SDK.

Since there is no game servers, the purchase should be validated on the client
side. Sample of the validation can be found in 2.3.5 Purchase Validation. After the
validation succeeds, the purchase can be completed.

The flow’s details are shown as below.
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2.2 Online login & purchase

Different from stand-alone flows, the game server can verify the login and receive
purchase order callback or initiatively query purchase order to/from the Unity IAP server
(the details of these APIs are shown in 2.2 Server side integration).

The flow’s details are shown as below.

(Note: Unity IAP for Xiaomi does not support inventory tracking, hence please do
not use PurchaseProcessingResult.Pending, which will not work for the purchase to be
called again when the app restart. Meanwhile, in Appendix: Best Practice there provides
an implementation of local inventory to prevent the losing of unfinished transaction when

server-side validation meets problems, for example, network issues.)
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3. Technical Integration

3.1 Onboarding to Unity

Before integration can start, Game developer first needs to onboard to Unity IAP
and will obtain the following developer credentials (these keys are binding to the project
and bundle id):

Unity Client Id

Unity Client Key

Unity Client Secret

Unity RSA public key



Meanwhile, Game needs to provide the appld, appKey and appSecret offered by
Xiaomi, and a callback URL of the Game server (if there exists one) to receive order
status update.

Before going live, Game developer will also need to provide Game server IP

addresses to be whitelisted on Unity IAP’s production server.

3.2 Server side integration

Product environment: https://cn-api.unity.com

Debug environment: https://cn-api-debug.unity.com

Server sample code (Java) could be found at https://unitytech.github.io/channel/

server-sample-code, it contains verifying Xiaomi logins (see 2.2.1), checking order

status (see 2.2.2), signing request data, and verifying Unity IAP server callbacks.

3.2.1 Verify Xiaomi Logins

GET
/v1/login-attempts/verifyLogin?

userLoginToken=<userLoginToken>&sign=<sign>

Parameters:
Attribute Name Required? | Description format | Sample
userLoginToken | Yes Unity user login | String eyJleHRIcm5hbEFw
token returned cElkljogljQwMzgwN
by client SDK o
when finishing TUOMzkiLCAiZXh0Z
login XJuYWxUeXBIljoglk
ZBSOVDSEwWILCAIZ
Xh0ZXJuYWxVaW

QiOIAIRKFLRUNITF



https://cn-api.unity.com/
https://unitytech.github.io/channel/server-sample-code
https://unitytech.github.io/channel/server-sample-code

9seXhoaylsICJleHR
lcm5hbFNIc3Npb24i
OiAIRKFLRUNITFOT
RVNTSU90In0=

s ves md> with String | dc03e329e44c80b
userLoginToken

and Unity Client 73d5bbfd30207de
Secret. Check 8f
the algorithm in
the end of the

doc
Response: in Json
Attribute Required? | Description Format Sample
Name
success Yes result of verify bool true
Xiaomi login
errMsg Yes the error String Invalid appld error
message of the
login if login failed
Sample:
Request:
GET

Iv1/login-attempts/verifyLogin?
userLoginToken=eyJleHRIcm5hbEFwcEIlkljogljQwMzgwNTUOMzkiLCAiZXh0ZXJuYWxUeXBlljog
IkZBSOVDSEWILCAiZXh0ZXJuYWxVaWQIiOiAiRKFLRUNITF9seXhoaylsICJleHRIcm5hbFNIc3Np
b24i0iAIRKFLRUNITFOTRVNTSU90INn0=&sign=ea24156d9c6fa3d527e99b9d644068ab



Response:

{

“success”: true

3.2.2 Check Order Status

GET
/v1/order-attempts/query?cpOrderld=<cpOrderld>&clientld=<clientld>&orderQueryToken=<order

QueryToken>&sign=<sign>

Parameters:

Attribute Name | Required | Description Format Sample
?

cpOrderld Yes order id assigned | String 66meab52wne
by game , or
Unity if game will
not generate it

clientld Yes client id assigned | String Q4AnJDW2-r

by Unity after _
onboarding xLAPujqrk1z
Q

orderQueryToken | Yes order query token | String XIAOMI
returned by client
SDK when
finishing
purchase

sign Yes md5 with String 7277da780d1
cpOrderld, 102864ee581
clientld, 8c2730c74e
orderQueryToken
and Unity Client
Secret. Check
the algorithm in
the end of the




doc

Response: in Json

Attribute
Name

Required?

Description

Format

Sample

id

Yes

orderAttempt id
assigned by
Unity

String

27487794382
6

clientld

Yes

client id returned
after Game
onboarding to
Unity IAP

String

Q4AnJDW2-r
xLAPujark1z
Q

cpOrderld

Yes

order id
assigned by
game , or Unity if
game will not
generate it

String

66mea52wne

uid

Yes

user id assigned
by Xiaomi

String

15400813498

status

Yes

status of the
orderAttempt

String

SUCCESS

productld

Yes

product id of the
product
associated with
the orderAttempt

String

Product_1

payFee

Yes

pay fee of this
order (in channel
unit)

Integer

quantity

Yes

quantity of the
product

Integer

notified

Yes

whether the
orderAttempt’s
status is notified
to Game server

Boolean

No




currency Yes currency ISO 4217 CNY
country Yes country ISO 3166-2 | CN
paidTime Yes orderAttempt 1ISO8601 2017-03-08T
paid time yyyy-MM-dd | 06:43:20Z
Thh:mm:ssX
XX, UTC
timezone
createdTime Yes orderAttempt 1ISO8601 2017-03-08T
created time yyyy-MM-dd | 06:43:20Z
Thh:mm:ssX
XX, UTC
timezone
updatedTime | Yes orderAttempt 1ISO8601 2017-03-08T
updated time yyyy-MM-dd | 06:43:20Z
Thh:mm:ssX
XX, UTC
timezone
createdBy Yes created by which | String 27487794382
user (only for 2
support use)
updatedBy Yes updated by String 0
which user (only
for support use)
rev Yes the revision of String 0
the orderAttempt
(only for update)
extension No extesion Json String {"abc" :
ll123ll}
Sample:
Request:

GET




Iv1/order-attempts/query?cpOrderld=<66mea52wne>&clientld=<Q4AnJDW2-rxLAPujgrk1zQ>&or
derQueryToken=<eyJjaGFubmVsVHIwZSI6ICJGQUtFQOhMIiwgImNoYW5uZWxVaWQiOiAiRkFL
RUNITF90eGQwWNSJ9>&sign=<debd0018911d263e23dfb729207b905c>

Response:
{
"createdBy" : "0",
"updatedBy" : "0",
"createdTime" : "2017-03-08T06:43:202",
"updatedTime" : "2017-03-08T06:43:202",
"id" : "274877943826",
"userld" : "274877943822",
"status" : "SUCCESS",
"cpOrderld" : "66mea52wne",
"clientld" : "Q4AnJDW2-rxLAPujqrk1zQ",
"uid" : "15400813498",
"productld" : "Product_1",
"payFee" : 1,
"quantity” : 1,
"paidTime" : "2017-03-08T06:43:20Z",
"notified" : false,
"currency" : "CNY",
"country" : "CN",

"reV" : ||1|l

3.2.3 OrderAttempt Callback Notification

Unity IAP server will notify the Game server with the order payment result.

Please implement the http GET and accept following query parameters.



Attribute Required? | Description Format
Name
signData Yes the order content which is in Json String
Json String format (details can
be seen in the table below)
signature Yes RSA signature with the String
signData. Check the algorithm in
the end of the doc
signData content:
Attribute Name | Required? [ Description Format Sample
orderAttemptld | Yes orderAttemptid | String 27487794382
assigned by 6
Unity
status Yes status of the String SUCCESS
orderAttempt
productld Yes product id of the | String Product 1
product
associated with
the orderAttempt
quantity Yes quantity of the Integer 1
product
extension No extesion Json String {"abc" : "123"}
paidTime Yes orderAttempt yyyy-MM-ddT | 2017-03-08
paid time hh:mm:ssXXX | 06:43:20
, GMT+8
timezone
cpOrderld Yes order id String 66meab52wne
assigned by
Game
clientld Yes client id returned | String P-wUONn9pbyQ




after Game TulksdkHX_Q
onboarding to
Unity IAP
country Yes currency String of ISO CNY
4217
currency Yes country String of ISO | CN
3166-2
payFee Yes pay fee of this String 1
order (in channel
unit)

Response:

Please return "ok". Or there will be retry notification in a time range.

Enum types:
1. status: SUCCESS, FAILED, UNCONFIRMED

Signature verification:
1. Api call:

. Any api call to Unity IAP server should have the parameter of signature.

a
b. Use all the parameters to calculate the sign if they are not null or empty.

o

The parameters should be urlDecoded.

d. Sort the parameters by alphabet of the attribute names, and then concatenate
the attribute values with the delimiter of &, finaly append the Unity Client Secret
at the end of the string to be signed

e. Do not use the sign in the sign string.

f.  Use md5 to hash the string. Use the lower case result to verify sign

Example:

When there is a call look like:

GET

Iv1/login-attempts/verifyLogin?



userLoginToken=eyJleHRIcm5hbEFwcEIkljogljQwMzgwNTUOMzkiLCAIZXh0ZXJuYWxUeXBlljog
IkZBSOVDSEWILCAIZXh0ZXJuYWxVaWQIiOIAIRKFLRUNITF9seXhoaylsICJleHRIcm5hbFNIc3Np
b24i0iAIRKFLRUNITF9TRVNTSU90IN0=&sign=ea24156d9c6fa3d527e99b9d644068ab

Then the string to be signed is
eydleHRIcm5hbEFwcEIkljogljQwMzgwNTUOMzkiLCAiZXh0ZXJuYWxUeXBlljoglkZBSOVDSEwiL
CAiZXh0ZXJuYWxVaWQIiOiAIRKFLRUNITF9seXhoaylsICJleHRIcm5hbFNIc3Npb24i0OiAiRKFLR
UNITF9TRVNTSU90IN0=&{SECRET}

where {SECRET} is the Unity Client Secret returned after onboarding.

2. Callback:
When Unity IAP server gives the callback notification to Game server, it will will
use RSA signature for verification. Please use the Unity RSA public key returned after

onboarding to verify the signData with the signature.

3.3 Client side integration

Install the “UnityChannel + Xiaomi UnitylAP beta plugin” in the game project.

Look at the sample script in /Assets/Plugins/UnityPurchasing/script/IAPDemo.cs.

This is copied into the Unity game project when the UnitylAP plugin is installed.

See Getting Started with Unity IAP to enable the “In-App Purchasing Service” for

the project.


https://docs.unity3d.com/Manual/UnityIAPSettingUp.html

= script

To build APK for Xiaomi MiPay store (not Samsung GALAXY, or GooglePlay)
target the store with menu, “Window” -> “Unity IAP” -> “Android” -> “Target Xiaomi
MiPay”. This enables Xiaomi + UnityChannel Java SDK. Use this to target different
supported Android app stores, before creating an APK build.

Help
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Bring All to Front
Unityﬁlﬁliiii
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% Target Google Play
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This is saved in a file:



: %, Assets » Plugins » UnityPurchasing|
B BillingMode

~ Resources

w
s ~ = BillingMode,json Qe

@ Inspector
__| BilingMode -8

{"androidStore":"XiaomiMiPay", "unityChannelTestMode":"Debug"} |

Below will show some code samples for how to use Unity IAP, all the details

could be found in the IAPDemo.cs

3.3.1 SDK Initialization

private IUnityChannelExtensions m_UnityChannelExtensions;

public void Onlnitialized (IStoreController controller, IExtensionProvider extensions) {

m_UnityChannelExtensions = extensions.GetExtension<IUnityChannelExtensions> ();

3.3.2 SDK Binding

Action initializeUnitylap = () => {
/I Now we're ready to initialize Unity IAP.
UnityPurchasing.Initialize(YourlmplementationOfIStoreListener, builder);

|3

Applnfo unityChannelApplinfo = new Applnfo();
/I Xiaomi appld

unityChannelApplInfo.appld = "abc123";

/I Xiaomi appKey
unityChannelApplinfo.appKey = "efg456";

/I UnityChannel Client Id
unityChannelApplnfo.clientld = "hij789";



/I UnityChannel Client Key
unityChannelApplnfo.clientKey = "kim012";

unityChannelLoginHandler = new UnityChannelLoginHandler();
unityChannelLoginHandler.initializeFailedAction = (string message) => {
Debug.LogError("Failed to initialize and login to UnityChannel: " + message);
|3
unityChannelLoginHandler.initializeSucceededAction = () => {
initializeUnitylap();
|3
/I Please do below initializations in the Awake() method
StoreService.Initialize(unityChannelApplnfo, unityChannelLoginHandler);

3.3.3 SDK Login

/Il The login succeeded callback will the userinfo as the parameter, in which:
/1 string userInfo.channel: the channel name, e.g. ‘XIAOMI’
/[ string userinfo.userld: the channel name and the channel uid,
/I string userlnfo.userLoginToken: Unity user login token used for server side ‘verifyLogin’ api
unityChannelLoginHandler.loginSucceededAction = (Userlnfo userinfo) => {
m_IsLoggedIn = true;
/I get channel type (XIAOMI) by userinfo.channel
/I get channel uid by userinfo.userld
/I get user login token by userinfo.userLoginToken
2
unityChannelLoginHandler.loginFailedAction = (string message) => {
m_IsLoggedIn = false;
Debug.LogError("Failed logging into UnityChannel. " + message);
2

StoreService.Login(unityChannelLoginHandler);

3.3.4 Catalog Setting

On the menu, “Window” -> “Unity IAP” -> “IAP Catalog”. Set the product “ID”.
In the “Advanced” -> “Store ID Overrides”, set the product id in “XiaomiMiPay”. Note:

Default “XiaomiMiPay” value is the same as for product “ID”.



IAP Catalog
test.product @

Required

Type: G L)

¥ Advanced
Locale: [En_us ™
Title: | |
Description: [ |

pT

¥ Store ID Overrides

AppleAppStore | |
GooglePlay [ |
SamsungApps
AmazonApps
MacAppStore [ |
TizenStore
WinRT
MoolahAppStore [ |
XiaomiMiPay ||test.product.xiaomi [ |

# Google Configuration

b Apple Configuration
[ Add Product ]]v
Catalog Export [ App Store Export
Apple SKU: H[ Apple Application Loader |
( Google Play CSV ]

Xiaomi MiPay Catalog

Next, to use the IAP Catalog product list in the script of the game project, either:
a) Read the catalog file. Remove all calls to “builder.AddProduct(...)" in your copy of
IAPDemo.cs and replace that code with this code which will read the IAP

Catalog:
var catalog = ProductCatalog.LoadDefaultCatalog();
foreach (var product in catalog.allProducts) {
if (product.allStorelDs.Count > 0) {
var ids = new IDs();
foreach (var storelD in product.allStorelDs) {
ids.Add(storelD.id, storelD.store);
}
builder.AddProduct(product.id, product.type, ids);
}else {

builder.AddProduct(product.id, product.type);

Or:



b) Manually input each product in the catalog. Add calls to “builder.AddProduct(
... )" for each Product ID in IAP Catalog.

3.3.5 Purchase Validation

3.3.5.1 Local Validation (Demonstrated in IAPDemo.cs)

If your game doesn’t have a server, you can validate receipt on the client

1) Add you public key in “Windows” -> “Unity IAP” -> “Receipt Validation Obfuscator” ->
“Unity Channel Public Key”, and click “Obfuscate Secrets”

2) Set “fetchReceiptPayloadOnPurchase” to true
builder.Configure<IUnityChannelConfiguration>().fetchReceiptPayloadOnPurchase = true

3) Using CrossPlatformValidator to validate the receipt. For example:

private CrossPlatformValidator validator = new CrossPlatformValidator(GooglePlayTangle.Data(),
AppleTangle.Data(), UnityChannelTangle.Data(), appldentifier);

public PurchaseProcessingResult ProcessPurchase(PurchaseEventArgs e)

/I Local validation is available for GooglePlay, Apple, and UnityChannel stores
if (m_IsUnityChannelSelected && m_FetchReceiptPayloadOnPurchase) {
try {
Debug.log(...)
var result = validator.Validate(e.purchasedProduct.receipt);
Debug.Log("Receipt is valid. Contents:");
foreach (IPurchaseReceipt productReceipt in result) {
Debug.Log(productReceipt.productID);
Debug.Log(productReceipt.purchaseDate);
Debug.Log(productReceipt.transactionID);

UnityChannelReceipt unityChannel = productReceipt as UnityChannelReceipt;
if (null != unityChannel) {
Debug.Log(unityChannel.productID);
Debug.Log(unityChannel.purchaseDate);
Debug.Log(unityChannel.transactionID);



/I For improved security, consider comparing the signed
/I lPurchaseReceipt.productld, IPurchaseReceipt.transactionID, and other data
/l embedded in the signed receipt objects to the data which the game is using
/I to make this purchase.
}
} catch (IAPSecurityException ex) {
Debug.Log("Invalid receipt, not unlocking content. " + ex);

return PurchaseProcessingResult.Complete;

3.3.5.2 Server Validation

Please refer to Section 3.2. The signData and signature can be obtained 1) through

“ValidateReceipt” API, as shown in “l/APDemo.cs”:
string txld = m_LastTransationID;
m_UnityChannelExtensions.ValidateReceipt(txld, (bool success, string signData, string signature) =>

{
Debug.LogFormat("ValidateReceipt transactionld {0}, success {1}, signData {2}, signature {3}",

txld, success, signData, signature);

/I May use signData and signature results to validate server-to-server

1;
2) through Product.receipt Payload part. Payload is a JSON hash with the following keys

and values:

gameOrderld |i.e. cpOrderld

productCode | The product code.

orderQueryTo | A token used to check order status as discussed in section 3.2.2

ken

json The singData, JSON encoded string contain detailed purchase
information

signature A signature for the json parameter.

signData content:

Attribute Name | Required? | Description Format Sample
orderAttemptld | Yes orderAttempt id | String 27487794382
assigned by 6
Unity




status Yes status of the String SUCCESS
orderAttempt
productld Yes product id of the | String Product_1
product
associated with
the orderAttempt
quantity Yes quantity of the Integer 1
product
extension No extesion Json String {"abc" : "123"}
paidTime Yes orderAttempt yyyy-MM-dd 2017-03-08
paid time hh:mm:ss, 06:43:20
GMT+8
timezone
cpOrderld Yes order id String 66meab52wne
assigned by
Game
clientld Yes client id returned | String P-wUONn9pbyQ
after Game TulksdkHX_Q
onboarding to
Unity IAP
country Yes currency String of ISO | CNY
4217
currency Yes country String of ISO | CN
3166-2
payFee Yes pay fee of this String 1

order (in channel
unit)

3.3.6 Duplicate Purchasing

Unity 5.5+

/ When user repeats purchasing a non-consumable they already own,

/I the PurchaseFailureReason will be set as DuplicateTransaction.

public void OnPurchaseFailed(Product item, PurchaseFailureReason r) {




if (PurchaseFailureReason.DuplicateTransaction == r) {

/I do something for duplicate pruchasing

}

m_PurchaselnProgress = false;

Unity 5.3 & Unity 5.4

/Il <summary>
/Il This will be called is an attempted purchase fails.
Il </summary>
public void OnPurchaseFailed(Product item, PurchaseFailureReason r)
{
Debug.Log("Purchase failed: " + item.definition.id);
Debug.Log(r);

if (m_IsUnityChannelSelected && r == PurchaseFailureReason.Unknown)
{
/I In Unity 5.3 and 5.4 the enum PurchaseFailureReason.DuplicateTransaction is
/I not available (is available in 5.5+) and can be substituted with
/I this call. Use this in OnPurchaseFailed for Unknown to determine
/I if the user already owns this item and that it can be added to
/I their inventory, if not already present.
var extra = m_UnityChannelExtensions.GetLastPurchaseError();
if (extra.Contains("DuplicateTransaction"))

{
/I Unlock ‘“item” in inventory if not already present.
}
}
m_PurchaselnProgress = false;
}
Note:

Developers can use the product.available ToPurchase bool field to determine if a product
is available from the Store’s Product Catalog. This field does not indicate ownership.
Developers can use the product.hasReceipt bool immediately after purchasing to
determine if a product is owned by the user, but this field will be reset to false when the
user restarts the application. There is essentially no support for Product Inventory in
Unity IAP. Therefore developers need to implement their own persistent Inventory for

some purpose, such as, restoring transaction.



Appendix

Best Practice

a.

Implementing local inventory

Unity IAP for Xiaomi does not support inventory tracking, which can lead to a
pending transaction being lost i.e. returning PurchaseProcessingResult.Pending will not
lead method ProcessPurchase called again. If you want to do server side integration and
make an unfinished transaction able to be handled again after a temporary network
issue, you can implement a simple local inventory to record the status of transactions.
Below shows a code sample:

First, store the transaction with the device storage when the purchase completes:
public PurchaseProcessingResult ProcessPurchase(PurchaseEventArgs e) {

if (m_IsUnityChannelSelected) {
var unifiedReceipt = JsonUtility.FromJson<UnifiedReceipt>(e.purchasedProduct.receipt);
if (unifiedReceipt != null && !string.IsNullOrEmpty(unifiedReceipt.Payload)) {
var purchaseReceipt =
JsonUtility.FromJson<UnityChannelPurchaseReceipt>(unifiedReceipt.P
ayload);
// Store the purchase with persistent inventory
Inventoryltem inventoryltem = new Inventoryltem();
inventoryltem.gameName = "...";
inventoryltem.productld = purchaseReceipt.productCode;
inventoryltem.productStatus = "PURCHASED";
inventoryltem.productReceipt = e.purchasedProduct.receipt;
savelnventory (e.purchasedProduct.transactionID, inventoryltem);

// client-to-server validate purchase
// unlock content

inventoryltem.productStatus = "PROVISIONED";
savelnventory (e.purchasedProduct.transactionID, inventoryltem);

}

return PurchaseProcessingResult.Complete;

[System.Serializable]
public class Inventoryltem {
public string gameName;
public string productld;
public string productStatus; // purchased -> provisioned
public string productReceipt; // product receipt generated by Unity IAP



private Dictionary<string, Inventoryltem> inventory = new Dictionary<string, Inventoryltem>();

private void savelnventory(string transactionID, Inventoryltem item) {
inventory [transaction|D] = item;
BinaryFormatter bf = new BinaryFormatter();
// custom file name
FileStream file = File.Open (Application.persistentDataPath + "/locallnventory.data”,
FileMode.Create);
bf.Serialize(file, inventory);
file.Close();

Then, each time the application restarts, you can load the inventory in initialization and
check if some transaction needs further handling:

public void Onlnitialized(IStoreController controller, IExtensionProvider extensions) {

// load persistent inventory and treat unfinished transaction
loadlnventory();
List<string> keys = new List<string> (inventory.Keys);
foreach (string key in keys) {

string transactionlD = key;

Inventoryltem inventoryltem = inventory[key];

if (inventoryltem.productStatus == "PURCHASED") {

// Step 1. validate purchase with inventoryltem.productReceipt

// validator.Validate(...)

// Step 2. after validation succeeded, unlock content

// Step 3. update product status

inventoryltem.productStatus = "PROVISIONED";

Debug.Log ("continue transaction in initialization. product id: " +
inventoryltem.productld);

// Step 4.

savelnventory(transactionlD, inventoryltem);

private void loadInventory() {
if (File.Exists(Application.persistentDataPath + "/locallnventory.data")) {
BinaryFormatter bf = new BinaryFormatter();
FileStream file = File.Open(Application.persistentDataPath + "/locallnventory.data”,
FileMode.Open);
inventory = (Dictionary<string, Inventoryltem>)bf.Deserialize(file);
file.Close();



